2016-Current Camaro 3.6 Supercharger Kit Installation Guide

Thank you for purchasing the Overkill supercharger system for your 6th gen
Camaro V6. This installation guide will help you through the install, but reach out
to me, Will, at willoverkill@gmail.com should you have any questions that I can
help resolve. Installation is recommended by a professional mechanic, or at
minimum an experienced DIY mechanic with good problem solving skills.

LEGAL DISCLAIMERS AND IMPORTANT INFORMATION, PLEASE READ BEFORE
INSTALLING THE SUPERCHARGER SYSTEM!!
-

-

-

-

-

Use extra caution when driving any modified vehicle. Increased power may
produce increased speeds that may make the vehicle unsafe or uncontrollable
and result in serious injury or death. Overkill does not condone speeding or
breaking any traffic laws. It is the responsibility of the purchaser, owner or
operator of the vehicle being modified with this supercharger system to
understand all risks associated with increasing the horsepower of a vehicle and
to obey all local traffic laws.
Overkill is not liable for any damages as a direct or indirect result of installing this
supercharger. The purchaser, installer or reseller of this supercharger system
cannot, under any circumstances, hold Overkill liable for any subsequent loss,
damages, fines or penalties. It is the responsibility of the purchaser, owner or
operator of the vehicle being modified with this supercharger system to
understand all risks associated with increasing the horsepower of a vehicle.
This supercharger system is NOT CARB approved and is not legal for use on
any public roads in the state of California. This system has not undergone any
approval for use on public roads. Despite all efforts to ensure no increased
emissions from normal vehicle operation, this system may not meet your local
emissions laws. It is the responsibility of the purchaser, owner or operator of the
vehicle being modified with this supercharger system to understand and comply
with all emissions laws associated with their vehicle.
Use of 91 octane or higher is REQUIRED with this supercharger system. Do not
use 87 octane, 89 octane, or E85 ethanol fuel. For all forms of racing or
sustained high speed use, it is recommended to use a mixture of 100+ octane
unleaded race fuel and the highest octane pump gas available. It is HIGHLY
RECOMMENDED to use the computer tuning services provided by Overkill or
the installer of this system to ensure the safe and proper operation of the engine
with this supercharger installed. Your provided HP Tuners can provide scans for
the owner/operator of the vehicle to view. It is the responsibility of the purchaser,
owner or operator of the vehicle being modified with this supercharger system to
understand all risks associated with increasing the horsepower of a vehicle, and
to understand for themselves how to identify unsafe and improper vehicle
operation which may lead to engine damage.
Installation of this system by a trained certified mechanic is HIGHLY
RECOMMENDED. It is the responsibility of the purchaser, owner or operator of
the vehicle being modified with this supercharger system to ensure the safe and
proper installation of this system to avoid damage to any of its components which
may not be covered under warranty due to installation error or abuse.

Installation Overview
Step 1: Remove Front Bumper
Step 2: Remove Air Filter Assembly
Step 3: Remove Intake Manifold, Install MAP Sensor, Spark Plugs
Step 4: Install Throttle Body Spacer and Reinstall Intake Manifold
Step 5: Install Crankshaft Pulley
Step 6: Install Tensioner To Mounting Plate
Step 7: Install Mounting Plates and Vortech Unit
Step 8: Remove Bumper Crash Support and Prep for Intercooler
Step 9: Install Front Intercooler and replace Bumper Crash Support
Step 10: Install Driver’s Side Intercooler Piping
Step 11: Install Passenger’s Side Intercooler Piping
Step 12: Modify MAF Wiring
Step 13: Install Intake and Air Filter
Step 14: Install Catch Can System
Step 15: Reinstall Front Bumper Fascia
Step 16: Install Vortech plug
Step 17: Final Checks Under The Hood
Step 18: Flash Tuning File
Before you begin the installation, ensure that you have followed the included
instructions to read the factory computer tuning from your vehicle and emailed it to
willoverkill@gmail.com and waited to receive your new supercharged tunes back
before attempting to install. This process may take several business days.
Disconnect your battery before starting the installation. Remove the negative
battery terminal and place a clean towel on the battery post to prevent contact.
From your dealership, you will need 500ml to a quart of power steering fluid
applicable to your year Camaro, plus a jug of Dexcool coolant, ideally premixed.
Recommended items to have: Blue Loctite, Dielectric Grease, WD40, Spark Plug
Gapping Tool, Electrical Tape, A Sharp Razor Blade, Drill, 3.5” Hole Saw, Allen
Socket and Torx Socket Bits for 3/8” Rachet, Torque Wrench, Full Socket Set,
Sturdy Scissors, Tub to catch oil that will drain, Zipties

Step 1: Install Your Tuning Software and Read the Factory Tuning
Before you start doing the installation, you must first read the factory tuning from
your vehicle to send to Overkill so that I can begin to write your new tuning while
you’re doing the installation. Do NOT make this the last step and then be concerned
when you’ll get the new tuning back because the car isn’t drivable after the install
without it, do this first!
Follow the additional instructions provided to operate the HP Tuner suite

Step 2: Remove Front Bumper
Let’s get the hard part out of the way and remove the front bumper and the inner
fender skirts to give room to work. Everything will be held together with what will
seem like a million screws, follow the location references in these following images
to remove all the screws and trim parts required, and finally remove the front bumper
fascia.

Step 3: Remove Air Filter Assembly
Onto an easier task, remove the factory air filter system, or whichever aftermarket
system you may have. We’ll outline the factory system, but refer to your aftermarket
manufacturer’s instructions as needed.
Unhook everything from the air ducting. Loosen the PCV breather tube’s band clamp
from the backside (#3/4), pinch the clip to remove the other smaller PCV hard line
from the left side (#1) and the air resonator tubing from the bottom (#2), then loosen
the clamps at the throttle body and air cleaner and remove the duct.

Unplug the MAF connector, remove the wiring from the air cleaner housing using an
auto trim tool to remove the plastic Christmas tree fastener, and pull up on the air
cleaner assembly to remove. You’ll want to remove the two T20 torx screws and
remove the MAF sensor from the cleaner assembly; you can do this later or now,
just keep the sensor safe as it’s fragile.
The air sound tube needs to be disconnected back at the firewall, it will be removed
entirely. Following the plastic tubing to a large round cylinder, at the diagonal brace
by the driver’s strut tower, and then back to the firewall, you’ll want to remove the
clips shown #1 below. At the firewall, you’ll see one bolt to remove from the fitting,
the turn the fitting counter clockwise to dislodge and remove. Taking the new firewall
cap fitting in the kit, insert and twist to lock in, and then use the bolt you removed to
re-secure the new fitting. Remove the sound tubing entirely from the vehicle.

Step 4: Remove Intake Manifold, Install MAP Sensor, Spark Plugs
Let’s remove the intake manifold, you’ll need to do this to change the spark plugs,
and it’s also a good opportunity to swap the MAP sensor.
Disconnect the EVAP solenoid electrical and hard line from just behind the throttle
body. Disconnect the throttle body electrical. Disconnect the MAP sensor wiring
harness at the back top of the manifold. Now reference the picture below, there will
be several horizontal bolts to remove, and the vertical bolts holding the intake
manifold down; remove them all and lift out the manifold.

With the manifold removed, locate the MAP sensor ontop of the manifold at the back
held on with one T20 torx screw, and swap it for the new MAP in our kit.
Using a spark plug socket with extension, go cylinder by cylinder to disconnect the
ignition coil electrical connector, remove the 10mm retaining bolt and remove the
coil, and change out the spark plugs. Using a gapping tool, check and ensure the
spark plugs have a .030-.032” gap. Use anti-seize on the threads and tighten to

factory spec. Use a little dielectric grease to lubricate the coil’s rubber seals for
easier re-installation.
Before reinstalling the manifold, now is a great time to look in the catch can hose
assembly bag and locate the largest hose with the largest plastic clip, this goes at
the very back of the engine. Follow the large plastic hose that’s remaining from the
intake tubing removal to the back of the engine, and reference your new fitting on
how to push the white clip in and pull the fitting back and off its port. Install the new
fitting and leave the hose accessible in the engine bay for the catch can install.

Step 5: Install Throttle Body Spacer and Reinstall Intake Manifold
Before reinstalling the intake manifold, good time to install the throttle body spacer. A
throttle body spacer is provided to provide engine vacuum to the blow off valve and to
the catch can system. You’ll have a spacer with two fittings preinstalled, a gasket and
longer bolts. Remove the throttle body by removing the 4 securing bolts, keep the
factory seal inplace on the manifold. Install the spacer with the straight vacuum fitting
facing the passenger’s side of the vehicle and the 90* fitting will face upwards and
towards the driver’s side. Using the longer provided bolts, secure the throttle body with
the provided gasket between the throttle body and plate and the rubber seal will seal the
manifold to plate on the other side, ensure its clean and in good shape and replace as
needed. The included ¼” hose will run from the side port to the blow off valve.
Reinstall the intake manifold now or at any point in the remaining installation. The main
bolts get torqued to 18 ft-lbs according to GM, and they provide this bolt torque
sequence.

Step 6: Install Crankshaft Pulley

One of the harder parts of the installation will be removing the crank pulley bolt. Using a
strong impact gun ideally, remove the bolt, this can often work better without swivel
connections and if you find there isn’t enough space to get your impact directly on the
bolt you can remove the cooling fan assembly with a couple bolts and 5 minutes of
work. Very importantly, measure the factory bolt that came off; it will either be 4” or
100mm, or it will be 117mm or just over 4.5”, there are two lengths of factory LGX crank
bolt and depending whether you have the shorter or longer will depend whether you use
the shorter or longer of the new bolts provided.
The factory pulley stays where it is and the new pulley will index into the OEM crank
pulley spokes; offer up the new supercharger crank pulley and rotate until it slots and
indexs in place and sits flush with the factory pulley. Use the appropriate new longer
bolt from the kit, again using the shorter if you have the shorter factory bolt or longer for
the longer as described above; a little blue or even red threadlocker is a wise decision,
use whenever possible. Personally I tighten with an impact gun using my judgement
and have not had an issue, however if you can use a torque wrench, tighten the new
bolt to 180 ft-lbs.

Step 7: Install Tensioner To Mounting Plate
To prepare to install the mounting plates, first attach the tensioner assembly to the outer
face plate with the Procharger attached. The tensioner will mount on the plate on the
side where the Procharger’s pulley is, and both that pulley and the tensioner pulley will
face the same direction. Use the included 3 bolts from the fastener’s kit and torque to 8
ft-lbs or 96 inch-lbs with blue Loctite recommended. Don’t overtorque these little bolts!

Step 8: Install Mounting Plates and Supercharger
Time to install the good stuff!
Once installed, the plates will look similar this, OF COURSE YOU”LL HAVE THE
PROCHARGER ATTACHED TO IT, but this gives you an idea of how it looks.

Identify first the components:
You’ll have the outer plate with the Procharger attached and tensioner now attached,
hereafter referred to as #1
You’ll have another plate that mounts to the engine block, referred to as #2
You’ll have 5 spacers in the fastener kit. Sort them first by their outer diameter, you’ll
have two larger diameter and 3 smaller diameter. Sort them now by length: you’ll have 3
that are the same length, two of smaller diameter and one larger diameter, put those 3
together as they go between the mounting plates, the guide will refer to the large
diameter spacer as #1 and the narrower diameter spacers as #2. The remaining two
spacers go between the engine plate and engine block, the large diameter will be
referred to as #3 and the smaller diameter as #4.
You’ll 5 bolts, let’s sort and label them. #1 will be a larger diameter bolt with a dome
rounded head (button head), while #2 will be a similarly large diameter bolt but with a
flat top bowl shape head (countersunk head). #3 will be the longest of the thinner bolts,
and #4 will be the two thinner bolts that are slightly shorter and same length as each
other.
Blue Loctite is recommended on all of the following bolts.
You may find you need to unbolt and rotate the cooling fan controller mounted on the
front of the cooling fan, use zipties to resecure in a position that offers clearance.
The engine plate connects to the front of the engine by removing the prominent 15mm
bolt from the front of the cylinder head, and locating a through hole on the side of the
cylinder head.

On the front of the engine where you’ve removed the bolt, grab bolt #1 and spacer #3,
slide the bolt through the engine plate then put the spacer inbehind, and thread it into
the engine until finger tight.
Use bolt #3 and slide it through the backside of the outer mounting position towards the
front of the vehicle, place spacer #4 over it and this will thread into the engine mounting
plate. Torque this bolt to 18ft-lbs and then back to bolt #1 and tighten to 35ft-lbs.

Use spacers #1 and #2, and bolts #2 and #4 to put the plates together; the thinner bolts
and spacers go to the top of the plates and come through the backside, and the larger
diameter closer to the tensioner goes through the front side. Torque screw #2 torque to
35 ft-lbs and #4 screws to 18 ft-lbs.
As required, you can unclip and unbolt the large A/C metal line from its mounts and
gently bend it out of the way of the mounting plates, this is not abnormal. Use zipties or
rebent the mounting tabs to resecure at your discretion.

When completed, the assembly will look like this…

Step 9: Installing the Intercooler
Remove the bolts on either side of the front crash support brace, which is the big metal
bracket that’s running side to side infront of the radiator. Remove completely so you can
install the intercooler.
You’ll need to move the horns. After unbolting from the crash support brace, use this
diagonal support brace bolt to mount the horn assembly.

You’ll need to completely remove the plastic air deflector around the front of the
radiator. You’ll see round washer-like push clips around the radiator edge holding it on,
pry them off one by one (careful as they like to fly off like projectiles) until you can
completely remove and discard this plastic deflector.
Put the intercooler inplace. You may find a metal A/C line on the driver’s side hits the
intercooler side tank, use a pry bar or just your strong hands to gently massage it to the
side and up out of the way. Once satisfied, reinstall the bumper support and secure with
its bolts to 32 ft-lbs. Install the intercooler mounting brackets to the top of the intercooler
with the dual bolt side on the crash bar upper face, and the single bolt hole facing
downward to slightly lower the intercooler. You can either install the intercooler’s tubing
first and allow some side to side adjustment of the intercooler before securing with its
mounting hardware, or secure now and adjust the tubing as needed, use your
judgement. When you’re ready, simple tighten the two bolts to the top bolt bosses on
the intercooler, and using the provided drill and tap secure with the 4 bolts provided to
the top face of the crash bar.

Step 10: Install Driver’s Side Intercooler Piping
Time to install the intercooler piping! The driver’s side is a one piece silicone tube,
which will ease installation.
You’ll want to prep by gently pushing this A/C line towards the radiator to make a little
extra clearance for the tubing to pass through the area.

Tip: Use WD40 to spray the outside of the tube to help slide it into place. The WD40 will
dry and not harm the silicone.
From the outside of the vehicle, slide the long straight section up into the engine bay
above that metal line and with a clamp over the outside first you can slide it over the
outlet of the Vortech. Should you need to reclock the positioning on the Vortech, there
are 6 allen head screws on the backside of the snail-like outer section of the Vortech,
you can loosen those slightly and rotate the outlet to the positioning that fits best, and
then be sure to retighten those 6 retaining bolts.
Next, align the other end of the silicone tube to the intercooler inlet. Once it’s in a
relative position, go back to the Vortech side and tighten its clamp first, ensuring to feel
with your fingers through the silicone skin that you’ve indeed got the clamp over the
outlet on the Vortech and not too near the edge, try and get the clamp up to the top of
the silicone as much as possible; if the silicone coupler is slightly loose over the
Vortech, this is normal, it will compress with the tightening of the clamp and resize itself

with a few heat cycles from driving the vehicle, just ensure to completely tighten the
clamp.
Now back at the other end, slide a clamp over and position the silicone tube over the
intercooler inlet, position and tighten the clamp at your discretion.
Old photo below shows a joint that won’t be there with the new one piece design but
you can see the relative positioning of the tubing.

Step 11: Install Passenger’s Side Intercooler Piping
Moving to the passenger’s side, you’ll need the following components to go from the
intercooler into the engine bay: 3” 90 degree Cobra head silicone elbow 
Preassembled Blow-Off Valve tube  3” 90 degree silicone elbow with one shorter and
one longer leg (orange interior)  smaller 3” 90* aluminum elbow  45* 3”-3.5” multisize silicone elbow (orange interior)  MAF housing  90* 3”-3.5” multi-size silicone
elbow.

The blow off valve will be positioned in the passenger’s fenderwell, with the tube
running parallel to the ground and front/back with the direction of the vehicle.

Prep by installing the MAF from the factory air filter housing into the new MAF housing.
Remove the MAF sensor from the factory air filter housing use a T20 torx bit. Note the
direction of the sensor and the open window with element that was facing towards the
air filter. Install into the new MAF housing with that window facing the screen mesh on
the one end of the new housing. Secure with the new allen head bolts.
The MAF connection ends of the 45* and the 90* silicone couplers are larger and will
take the large T-Bolt clamps.
Tip: Use WD40 on the INSIDE of the silicone coupler joints to provide temporary
lubrication to rotate and position the connections before tightening the clamps.

Preassemble the blow off valve tee to the shorter end of the Cobra head 90* elbow, it
doesn’t matter which way the BOV goes. The 90* silicone elbow (orange inside) will be
precut with a short end and a long end, the short end will go to the blow off valve BOV
tee, but in the meantime preassemble the long end to the metal 90* elbow. Stick the
metal elbow through into the engine bay, then assemble the BOV tee to the 90* silicone
short end and attach the Cobra elbow to the outlet of the supercharger. Don’t forget
clamps and WD40 on each connection. Rotate the connections and use the ability to
slide the BOV tee pipe in its silicone couplings to get a good fit on the metal elbow going
into the engine bay, you’ll want that elbow outlet facing straight up in the engine bay and
you should find the BOV tee is on a slight upward angle from the intercooler connection.
Go in sequence now and tighten the clamps to the BOV tee and intercooler.
Install the MAF into the 45* silicone elbow with the MAF sensor pointed downward and
with the screen end facing into this elbow. With WD40 sprayed, slide the narrow end of
this 45* silicone elbow over the metal elbow that’s now in the engine bay and facing
upward. Secure the remaining connection from the MAF to the throttle body with the
reducing size 90* silicone elbow (black inside). Check your connections for a good fit,
rotate and slide as needed, and ensure the MAF wiring is clear of the serpentine belt
system and anything else. Now go in sequence tightening all the clamps to secure the
tubing.

Now is a good time if you’ve not done so yet to take the ¼” hose from the BOV throttle
body spacer kit and run it from the spacer to the BOV vacuum fitting on its top.

Take the MAF wiring extension harness, plug in the MAF, route the wiring in the manner
you see fit (try securing it with zip ties to the factory harness) and plug in the harness
end.

Step 13: Install Intake and Air Filter
Let’s complete the installation on the driver’s side by installing the air intake and filter.
You may feel the need to cut off or trim this air cleaner mounting bracket if it touches the
silicone elbow.

Shown is the old silicone elbow but the new elbow will be multi-size and have one very
short leg, this goes over the inlet of the Procharger. Note that it will have a hole drilled in
it, this is for the catch can fitting and normal! Install over the Procharger inlet and keep
mildly tight at the moment in-case you need to rotate it. Attach the air filter to the large
90* aluminum elbow. Slide the aluminum elbow up from the fenderwell and into the
silicone elbow. Try and get the filter and tubing up as close to the headlight as possible
for clearance from the fender liner. Once you’re happy with the alignment, tighten down
all the clamps.

Step 14: Install Catch Can System
Installing the catch can is very important. Without this system inplace, oil will get into
your engine, your valves, piston tops, into your intercooler system and into your
supercharger even. However with it in place, you’ll be amazed at the oil it prevents
entering these crucial areas and will help prolong engine life considerably.
Your catch can will include a bunch of new preassembled hoses and the can itself with
mounting brackets. The can should be mounted over near the supercharger where the
air cleaner box once sat.
There are 4 lines to be run in total. Follow along in the sequence step by step, reread as
many times as you need to, and you’ll be able to install the catch can successfully.
First lets mount the can. Slide the can into the ring mount which will be attached to a
bracket; this bracket goes over by the driver’s strut tower, you’ll see its black brace and
two bolts to the strut tower, remove those bolts, use the 2 short spacers and long bolts
in the kit to temporarily secure the bracket in place, and fit the can in place. You can
slide the ring mount up and down on the main bracket, and you can slide the can inside
the ring mount; use your discretion to get the can in a good positioning and as high as
possible, then start tightening down the bolts to secure the ring clamp (remove the main
bracket as needed to access the bolts). With everything secure, tighten down the two
bolts on the main bracket.

Line #1 connects to the large hard plastic running the length of the intake manifold on
the driver’s side. The line has a short length of the large 5/8” size and reduces to 3/8”;
connect the larger end to the plastic factory line and then run in a cosmetically pleasing
fashion over to the center port on the catch can, trim its length as you desire with a knife
or scissors and slide it over the center port barb.
Line #2 is a short hose with a check valve. Attach to the top port of the throttle body
spacer and connect to an outer port on the catch can, trim the catch can end as desired
but do not shorten the line where the check valve is closest to, there is a flow restrictor
in the rubber line that you don’t want to cut out.

Line #3 is a longer 3/8” line (that may include a 90* plastic barb at one end) and a check
valve in it. This line runs from the elbow in front of the Procharger inlet to the other outer
port on the catch can. Locate the predrilled hole in the inlet silicone elbow, insert the 90*
barb fitting (or the end with the check valve closest to it) to the silicone elbow, trim the
catch can end of the hose as desired for fit.
Ensure to secure now all the swivel barbs on the catch can, you’ll want them snug and
secure to avoid vacuum leaks. Also check and ensure the drain valve is closed, it’ll be
perpendicular to the drain valve or horizontal to the ground; vertical or inline with the
fitting means the valve is open and again you’ll have a vacuum leak, plus the can will
drip oil, yuck, so keep that closed.
Line #4 is a 3/8” hose that will have a tee and two shorter lengths, these go to the ports
on the front of the valve cover where you removed the factory plastic connections from
the air intake tubing. Slide the ends over the barbs on the valve covers. The other end
goes to the barb that’s preinstalled in the neck of the air filter, run the hose down the
filter as desired, trim to length and install over this barb.

Step 15: Reinstall Front Bumper
Time to reinstall the front bumper fascia and button up the car. Refer to the original
disassembly process, and just do everything in reverse.
Step 18: Fill the Procharger with oil
Using the included package, fill the Procharger with a full 6oz bottle of oil.

Step 17: Final Checks Under The Hood
Time to check everything you’ve installed. Look for the following items:
-

Things are clear from the serpentine belt
Things are clear from the exhaust downpipes
Intercooler piping isn’t clunking against the subframe, adjust if so to correct
Check the fluid level in the supercharger. It comes prefilled. Do not overfill.
Check all clamps are tight
Check that the catch can fittings are tight and the drain valve is closed
Secure the drain lines of the supercharger and catch can.

Step 18: Flash Tuning
Select Your Overkill tuning files for your supercharger system from your email and flash
to the vehicle using the flashing process.
Don’t forget once installed and running that you’ll want to send driving scans to Overkill,
follow the instructions to get that done for potential tune revisions required.

HP Tuner instructions

Step 1: Install software on your PC
In the HP Tuners kit is a USB stick, and on it is the software to install on your PC You can
also find the HP Tuners software on their website which will be their most up to date
versions and may be the best way to go, you can find it at www.hptuners.com/downloads
Download the “Download VCM Suite: Latest Full Version” in the upper left, and if you need
them you can also download the MPVI2 Drivers on that page. Plug your HP Tuners MPVI2
module into your PC using the USB cable, install the software.

Next, open VCM

Editor, go to Help > Resync Interface, and that’ll pole the module for
your licensing information that has been preloaded; you will need to be
connected to the internet. Ok, ready to go to the vehicle.

Step 2: Reading your Factory Tuning
Using the HP Tuner MPVI2 module and supplied USB cable, connect to your vehicle’s OBD2
port below the dash. Turn the key or ignition to “on” or “run”, so the instrument cluster
lights up, but do NOT start the engine. If you have a push button start, press and hold the
start button with your foot off the brake pedal for about 10 seconds to put the vehicle
into run mode. Wait 20 seconds from turning the ignition on before you begin a read of any
of the computer modules, to allow them time to boot up and run their startup system
checks. Turn the radio off and the HVAC system off to conserve battery power, you can
also turn off the headlights if its dark out.

In the VCM Editor program, to go Flash > Read Vehicle; in the popup window that opens,
click the Gather Information button.

Once it poles the vehicle, you’ll see a new pop up window with options to read the various
computers that are supported. Always have the engine ECM computer at the top set to
Read Entire, and if you’re an automatic transmission you’ll want the transmission TCM
computer set to Read Entire.

If you see an option for the FSCM which is

the fuel pump computer, set this to “Do Not Read” unless you have
instructions otherwise from me, otherwise it will cost you 1 extra
credit that you’ll need to purchase with your own money!!

With those set, click Read and let it do its thing, the read will take typically 3-5 minutes
on most GM vehicles but if you have a Pontiac G8 3.6, a 2005-11 CTS with the 3.6, 2010-11
Camaro 3.6, the engine computer read could take upwards of 25 minutes so be prepared. If
you have a 2017+ GM vehicle, you may get a message that the tuning can’t be read at this
time and try again later, if so ensure you’re connected to the internet to allow the HP
Tuner suite to send the file to HP Tuners, and then try again in about 1 hour.
Once completed, save the file as your name, your vehicle, and “factory” or “stock” so you
know that this was your factory computer tuning should you ever need to access it again.
Email the file that you just saved to willoverkill@gmail.com. I will typically get your tune
back to you within 48 hours (excluding weekends), you can follow up with an email if you
don’t hear in that timeframe, keep in mind it takes me an hour typically to write the initial
tuning for every vehicle I do so it won’t be an instantaneous process!

Step 3: Flash your Overkill Tunes

When you receive back your Overkill tune files, they’ll be labelled as Overkill or OK and
then Supercharger. Subsequent revisions will be labelled Mod1, Mod2 etc. If you’re
automatic transmission equipped, you’ll have your Overkill transmission settings in this file.
At some point in the flash, you’ll be asked to license the vehicle and file. When the screen
comes up, click Licensing Options, select Specific Vehicle and click ok to license your
vehicle with the included credits.
To flash the tune to the vehicle, open up VCM Editor, go to File > Open and select the tune
that you wish to run. Go to Flash > Write Vehicle, and for the computer options that come
up you’ll want to see Write Calibration selected.

Turn the key or ignition to “on” or “run”, so the instrument cluster lights up, but do NOT
start the engine. If you have a push button start, press and hold the start button with
your foot off the brake pedal for about 10 seconds to put the vehicle into run mode. Wait
15-20 seconds from turning the ignition on before you begin a write of any of the
computer modules, to allow them time to boot up and run their startup system checks. You
can now click Flash and let the system upload the tunes to your vehicle. Do not interrupt
this process by using the computer for other things, disconnecting the cable by accident
or otherwise, fidgeting with the stereo or hvac or etc, it is very very important not to

interrupt the writing process, you may leave your vehicle inoperable! This is rare but can
happen. If for any reason the flashing process is interrupted, do not turn off the ignition,
check all your connections and try immediately to flash again, you should see the HP Tuner
suite recover and reboot the flashing process.
Once the flashing process is computer, and you see Write Complete for all the computers
selected, you can turn off the ignition, wait 10 seconds, and then start your vehicle. If you
have a push button start, turn the ignition on and then off again, you may find it doesn’t
try to start the first time, just try again and it should fire up.
Your vehicle will now be programmed with Overkill tuning!

Step 4: Taking a Driving Scan
While you’ve received your Overkill tunes programmed to your modifications, it’s always
beneficial to take a driving scan and send that scan data to Overkill so your tune can be
further refined as needed.
Open the VCM Scanner, connect your laptop to the vehicle with the cable/module, start
your vehicle up (this time its ok to use this suite while the engine is running). Go to the
excel like table on the left side of the scanner, to the top and you’ll see a button that says
Recent Channel Configs, click on that, Open Channel Config and select the .xml file that
I’ve emailed with your tunes (email me back for one if you don’t see it attached).

Now go to Vehicle > Connect and Vehicle > Start Scanning, confirm that you see the
parameters on that table in the right hand column changing as it gets information from the
computer.
Now go ahead and drive the vehicle. Take about a 10 minute scan, nothing too short, try
not to be overly long as the file becomes huge to try and sift through on my end, and
include your regular driving habits, include some brief full throttle if you can such as a
highway ramp entrance or a 0-60 run in an appropriate area, and at the end of the scan
include about 30 seconds of idling. When finished, go to Vehicle > Disconnect, then Log File
> Save Log File As, save it as your name and what tune you’re running (John Smith OK93
for example) and add the date if you choose, then email me that file to
willoverkill@gmail.com. I’ll look at the data, revise the tune as needed and email that back
within 5 business days.

